IaaS Integration for HP Server Automation

12 April 2018
vRealize Automation 7.4
You can find the most up-to-date technical documentation on the VMware website at:
https://docs.vmware.com/
If you have comments about this documentation, submit your feedback to
docfeedback@vmware.com
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>IaaS Integration for HP Server Automation</td>
<td>4</td>
</tr>
<tr>
<td>1 HP Server Automation Overview</td>
<td>5</td>
</tr>
<tr>
<td>2 Install the HP Server Automation PowerShell Snap-In</td>
<td>7</td>
</tr>
<tr>
<td>Set the PowerShell Execution Policy to RemoteSigned</td>
<td>7</td>
</tr>
<tr>
<td>3 Install an EPI Agent for HP Server Automation</td>
<td>9</td>
</tr>
<tr>
<td>4 Extend the Default Software Installation Timeout</td>
<td>12</td>
</tr>
<tr>
<td>5 Integrating HP Server Automation</td>
<td>13</td>
</tr>
<tr>
<td>Enable Provisioning from HP Server Automation Boot Images</td>
<td>13</td>
</tr>
<tr>
<td>Preparing an HP Server Automation Template for Cloning</td>
<td>14</td>
</tr>
<tr>
<td>Prepare a Reference Machine for Linux</td>
<td>14</td>
</tr>
<tr>
<td>Prepare a Reference Machine for Windows</td>
<td>15</td>
</tr>
<tr>
<td>6 Enable vRealize Automation Software Installation from HP Server Automation</td>
<td>17</td>
</tr>
<tr>
<td>7 Creating Blueprints for HP Server Automation</td>
<td>18</td>
</tr>
<tr>
<td>Create a Virtual Blueprint for Creating from an HP Server Automation Boot Image</td>
<td>18</td>
</tr>
<tr>
<td>Create a Blueprint for Cloning from an HP Server Automation Template</td>
<td>20</td>
</tr>
<tr>
<td>8 Custom Properties for HP Server Automation Integration</td>
<td>22</td>
</tr>
<tr>
<td>9 Publish a Blueprint</td>
<td>25</td>
</tr>
</tbody>
</table>
IaaS Integration for HP Server Automation

*IaaS Integration for HP Server Automation* provides information about integrating HP Server Automation with VMware vRealize™ Automation.

This documentation provides information on how you can use an HP Server Automation boot image or an HP Server Automation template to provision virtual machines by cloning.

**Intended Audience**

This information is intended for system administrators, tenant administrators, fabric administrators, and business group managers of vRealize Automation. This content is written for experienced Windows or Linux system administrators who are familiar with virtualization technology and the basic concepts described in *Foundations and Concepts*.

**VMware Technical Publications Glossary**

VMware Technical Publications provides a glossary of terms that might be unfamiliar to you. For definitions of terms as they are used in VMware technical documentation, go to [http://www.vmware.com/support/pubs](http://www.vmware.com/support/pubs).
HP Server Automation Overview

You can can provision virtual machines by using an HP Server Automation boot image or by provisioning by cloning and using an HP Server Automation template when you integrate HP Server Automation with vRealize Automation.

You can optionally identify the HP Server Automation policies to make available in vRealize Automation. Machine requestors can select from among these policies to install software on the requested machine, or you can specify HP Server Automation policies in the blueprint to be applied to every machine that is provisioned from that blueprint.

Integration Requirements Overview

The following is a high-level overview of the requirements for integrating HP Server Automation with vRealize Automation:

- A system administrator installs Microsoft PowerShell on the installation host prior to installing the agent. The required version of Microsoft PowerShell depends on the operating system of the installation host and might have been installed with that operating system. See Microsoft Help and Support.

- A system administrator installs the HP Server Automation snap-in on at least one host for vRealize Automation external provisioning integration (EPI) installation. See Chapter 2 Install the HP Server Automation PowerShell Snap-In.


- A system administrator installs at least one EPI agent. See Chapter 3 Install an EPI Agent for HP Server Automation.

- A system administrator sets up the selected integration method. See Chapter 5 Integrating HP Server Automation.

- A system administrator enables software installation from HP Server Automation. See Chapter 6 Enable vRealize Automation Software Installation from HP Server Automation.

- A tenant administrator or a business group manager creates a blueprint that enables the deployment of software jobs. See Chapter 7 Creating Blueprints for HP Server Automation.
- A tenant administrator or a business group manager publishes the blueprint. See Chapter 9 Publish a Blueprint.
Install the HP Server Automation PowerShell Snap-In

The HP Server Automation snap-in must be installed on at least one host for vRealize Automation external provisioning integration (EPI) installation prior to installing the EPI agent.

Prerequisites

- Obtain the HP Server Automation Snap-in software from the HP Server Automation installation media.
- Log in to the vRealize Automation console as a system administrator.

Procedure

1. Click Start, right-click Command Prompt, and click Run as administrator.
2. Change to the directory that contains the PowerShell snap-in.
3. Type `msiexec /i OPSWpowershell-37.0.0.5-0.msi`.
4. Complete the installation by accepting all defaults.
5. Select Start > All Programs > Windows PowerShell 1.0 > Windows PowerShell.
6. Type `Add-PSSnapin 'OpswareSasPs'`.
7. Type Exit.

Set the PowerShell Execution Policy to RemoteSigned

You must set the PowerShell Execution Policy from Restricted to RemoteSigned or Unrestricted to allow local PowerShell scripts to run.

- For more information about PowerShell Execution Policy, type `help about_signing` or `help Set-ExecutionPolicy` at the PowerShell command prompt.

Prerequisites

- Log in as a Windows administrator.

Procedure

2. Type `Set-ExecutionPolicy RemoteSigned` to set the policy to RemoteSigned.
3. Type `Set-ExecutionPolicy Unrestricted` to set the policy to Unrestricted.
4. Type `Get-ExecutionPolicy` to verify the current settings for the execution policy.
5. Type `Exit`. 
Install an EPI Agent for HP Server Automation

A system administrator must install at least one vRealize Automation EPI agent to manage interaction with HP Server Automation. The agent can be installed anywhere, including the vRealize Automation server or the HP Server Automation server, as long as the agent can communicate with both servers.

Prerequisites

- Verify that the HP Server Automation PowerShell Snap-in is installed on the same host as your EPI agent. If the EPI agent is installed before the snap-in, then the agent service must be restarted after the snap-in is installed. See Chapter 2 Install the HP Server Automation PowerShell Snap-In.
- The agent must be installed on Windows Server 2008 SP1, Windows Server 2008 SP2 (32 or 64-bit), Windows Server 2008 R2 system, or Windows 2012 with .NET 4.5.
- The credentials of the agent must have administrative access to all HP Server Automation hosts with which the agent will interact.
- Install the IaaS components, including the Manager Service and Website.
- See Installing vRealize Automation for complete information about installing vRealize Automation agents.
- Log in to the vRealize Automation console as a system administrator.

Procedure

1. Select Custom Install and Proxy Agent on the Installation Type page.
2. Accept the root install location or click Change and select an installation path.
   
   Even in a distributed deployment, you might sometimes install more than one IaaS component on the same Windows server.
   
   If you install more than one IaaS component, always install them to the same path.
3. Click Next.
4. Log in with administrator privileges for the Windows services on the installation machine.
   
   The service must run on the same installation machine.
5. Click Next.
6. Select EPIPowerShell from the Agent type list.
7 Enter an identifier for this agent in the **Agent name** text box.

Maintain a record of the agent name, credentials, endpoint name, and platform instance for each agent. You need this information to configure endpoints and to add hosts in the future.

**Important** For high availability, you may add redundant agents and configure them identically. Otherwise, keep agents unique.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redundant agent</td>
<td>Install redundant agents on different servers. Name and configure redundant agents identically.</td>
</tr>
<tr>
<td>Standalone agent</td>
<td>Assign a unique name to the agent.</td>
</tr>
</tbody>
</table>

8 Configure a connection to the IaaS Manager Service host.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a load balancer</td>
<td>Enter the fully qualified domain name and port number of the load balancer for the Manager Service component, <em>mgr-svc-load-balancer.mycompany.com:443</em>. Do not enter IP addresses.</td>
</tr>
<tr>
<td>Without a load balancer</td>
<td>Enter the fully qualified domain name and port number of the machine where you installed the Manager Service component, <em>mgr-svc.mycompany.com:443</em>. Do not enter IP addresses.</td>
</tr>
</tbody>
</table>

The default port is 443.

9 Configure a connection to the IaaS Web server.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a load balancer</td>
<td>Enter the fully qualified domain name and port number of the load balancer for the Web server component, <em>web-load-balancer.mycompany.com:443</em>. Do not enter IP addresses.</td>
</tr>
<tr>
<td>Without a load balancer</td>
<td>Enter the fully qualified domain name and port number of the machine where you installed the Web server component, <em>web.mycompany.com:443</em>. Do not enter IP addresses.</td>
</tr>
</tbody>
</table>

The default port is 443.

10 Click **Test** to verify connectivity to each host.

11 Click **Opsware** in **EPI Type**.

12 Type the fully qualified domain name of the managed server in the **EPI Server** text box.

Optionally, you can leave this blank to let the agent interact with multiple hosts.

The HP Server Automation server with which the agent interacts when provisioning a machine by using HP Server Automation depends on the value of the required custom property, `EPI.Server.Name`, in the blueprint.
Therefore, if you install a dedicated EPI agent by specifying an HP Server Automation server name during installation, only machines whose EPI.Server.Name property exactly matches the server name configured for the agent can be provisioned by that server.

If you install a general EPI agent by not specifying an HP Server Automation server name during installation, a machine can be provisioned by any server specified in the blueprint EPI.Server.Name property, that is assuming the agent can contact that server.

**Note** If no matching agent can be found, or there are no agents with unspecified server values, Opsware provisioning will wait until a suitable agent is found.

13 Click **Add**.

14 Click **Next**.

15 Click **Install** to begin the installation.

After several minutes a success message appears.

16 Click **Next**.

17 Click **Finish**.

**What to do next**

Determine the type of integration method to use. See Chapter 5 Integrating HP Server Automation.
Extend the Default Software Installation Timeout

When you install the software for the integration product, the software might take longer to install than the default 30-minute timeout. You can increase the default timeout to a value that allows the installation to finish.

Procedure

1. Navigate to the Manager Service installation directory. Typically, this is %System-Drive%\Program Files x86\VMware\vCAC\Server.
2. Create a backup of the ManagerService.exe.config file.
3. Open the ManagerService.exe.config file and locate the workflowTimeoutConfigurationSection element and increase the value of the DefaultTimeout attribute from 30 minutes to your desired limit.
4. Click Save and close the file.
5. Select Start > Administrative Tools > Services, and restart the vRealize Automation service.
Integrating HP Server Automation

The steps required to integrate HP Server Automation with vRealize Automation depend on which provisioning method you want to use and whether you want to enable software installation from HP Server Automation.

When provisioning virtual machines, you can select from the following integration methods:

- Provision by using a system from which HP Server Automation deploys images that is available on the network.
- Provision by cloning by using a template that is prepared for HP Server Automation.

You can optionally identify the HP Server Automation policies to make available in vRealize Automation. Machine requestors can select from among these policies to install software on the requested machine, or you can specify HP Server Automation policies in the blueprint to be applied to every machine that is provisioned from that blueprint.

This chapter includes the following topics:

- Enable Provisioning from HP Server Automation Boot Images
- Preparing an HP Server Automation Template for Cloning

Enable Provisioning from HP Server Automation Boot Images

A system administrator can use an HP Server Automation boot image to enable vRealize Automation to provision machines by using that instance of HP Server Automation.

**Prerequisites**

- A system from which HP Server Automation deploys images is available on the network.
- An EPI agent installed. See Chapter 3 Install an EPI Agent for HP Server Automation.
- Log in to the vRealize Automation console as a system administrator.

**Procedure**

1. On the EPI/Opsware Agent host, select Start > Administrative Tools > Services, and stop the vRealize Automation EPI/Opsware Agent.
On the EPI agent installation host, which may be the same as the Manager Service host, change to the EPI agent installation directory, typically %SystemDrive%\Program Files (x86)\VMware\vCAC Agents\agent_name.

Edit the agent configuration file, VRMAgent.exe.config, in the EPI agent installation directory.

- Locate the following line.

```xml
<DynamicOps.Vrm.Agent.EpiPowerShell
    registerScript="CitrixProvisioningRegister.ps1"
    unregisterScript="CitrixProvisioningUnregister.ps1"/>
```

- Change the line to match the following line.

```xml
<DynamicOps.Vrm.Agent.EpiPowerShell
    registerScript="CreateMachine.ps1"
    unregisterScript="DisposeVM.ps1"/>
```

Create an HP SA password file in the Scripts folder.

The credentials you provide for this file must have administrator access to all instances of HP SA with which the agent will interact.

- Select Start > All Programs > Windows PowerShell 1.0 > Windows PowerShell.
- Change to the Scripts directory.
- Type \CreatePasswordFile.ps1 username.
- Type the password when prompted.
- Type Exit.

On the vRealize Automation EPI/Opsware Agent host, select Start > Administrative Tools > Services, and then start or restart the vRealize Automation EPI/Opsware Agent service.

Preparing an HP Server Automation Template for Cloning

You can use an HP Server Automation template to integrate with vRealize Automation.

To create the HP Server Automation template, you must create a reference machine and add customization specifications to it.

For Windows, see Prepare a Reference Machine for Windows.

For Linux, see Prepare a Reference Machine for Linux.

Prepare a Reference Machine for Linux

You must prepare a reference machine and convert it to a template for cloning to add software installation by HP Server Automation to provisioning by cloning.
Procedure

1. Add the HP Server Automation agent installation package to the cloning template.
2. Copy the HP Server Automation agent installer to the reference machine.
3. Create a script to run the installer and install the HP Server Automation agent.
4. Copy the script to the reference machine.
5. Add the customization required to invoke the agent after provisioning, so that the agent is installed on each cloned machine.

Note: Do not install HP Server Automation on the reference machine. The agent must be installed by using the customization specification or postinstall script following cloning.

What to do next

- Optionally, identify the HP Server Automation policies to make available in vRealize Automation. See Chapter 6 Enable vRealize Automation Software Installation from HP Server Automation.
- Create a blueprint for the type of HP Server Automation integration you want to enable. See Chapter 7 Creating Blueprints for HP Server Automation.

Prepare a Reference Machine for Windows

You must prepare a reference machine and convert it to a template for cloning before you can add software installation by HP Server Automation to provisioning by cloning.

Procedure

1. Add the HP Server Automation agent installation package to the cloning template.
2. Copy the HP Server Automation agent installer to the C:\ directory of the reference machine.
3. Add the customization required to invoke the agent after provisioning, by adding following line to the Run Once section of the customization specification.

   ```
   C:\opswareagentinstaller --opsw_gw_addr opswareipaddress:3001 -s --force_sw_reg
   --force_full_hw_reg
   ```

   This customization also installs the agent on each cloned machine.
4. Replace `opswareagentinstaller` with the name of the HP Server Automation agent installer executable.
5  Replace `opswareipaddress` with the IP address of the server that is hosting the HP Server Automation instance that installs the software.

For example:

```
C:\ opsware-agent-37.0.2.61-win32-6.8.exe --opsw_gw_addr 10.20.100.52:3001 -s --force_sw_reg --force_full_hw_reg
```

**What to do next**

- Optionally, identify the HP Server Automation policies to make available in vRealize Automation. See Chapter 6 Enable vRealize Automation Software Installation from HP Server Automation.
- Create a blueprint for the type of HP Server Automation integration you want to enable. See Chapter 7 Creating Blueprints for HP Server Automation.
Enable vRealize Automation Software Installation from HP Server Automation

A system administrator can optionally identify the HP Server Automation policies to make available in vRealize Automation. Machine requestors can select from among these policies to install software on the requested machine, or HP Server Automation policies can be specified in the blueprint to be applied to every machine that is provisioned from that blueprint.

Prerequisites

- An EPI agent installed. See Chapter 3 Install an EPI Agent for HP Server Automation.
- Log in to the vRealize Automation console as a system administrator.

Procedure

1. Create a text file named Software.txt in the Web site directory under the vRealize Automation server install directory, typically %SystemDrive%\Program Files (x86)\VMware\vCAC\Server\Website.

   Each line of the Software.txt file must be in the following format:

   `Software_policy_description=software_policy_name`

2. Define the label and name of the software policy that a user sees when they request to install software from the HP Server Automation instance.
   a. Replace `Software_policy_description` with the label that identifies the software policy.
   b. Replace `software_policy_name` with the name of the policy.

   For example, a Software.txt file, where you want to provide the user the ability to select HP Server Automation Windows ISM Tool, HP Server Automation Linux ISM Tool, or both, might contain the following information:

   ```
   HP SA Windows ISM Tool=Windows_ISMtool
   HP SA Linux ISM Tool=RedHatLinux_ISMtool
   ```
Creating Blueprints for HP Server Automation

The type of blueprint you create depends on how you want to enable HP Server Automation integration.

You need to create a blueprint that includes all of the information required for machine provisioning and the information required for HP Server Automation integration for either of the following integration methods:

- Provisioning by using a system from which HP Server Automation deploys images.
- Provisioning by cloning from a template that is prepared for HP Server Automation.

You can optionally identify the HP Server Automation policies to make available in vRealize Automation. Machine requestors can select from among these policies to install software on the requested machine, or you can specify HP Server Automation policies in the blueprint to be applied to every machine that is provisioned from that blueprint.

This chapter includes the following topics:

- Create a Virtual Blueprint for Creating from an HP Server Automation Boot Image
- Create a Blueprint for Cloning from an HP Server Automation Template

Create a Virtual Blueprint for Creating from an HP Server Automation Boot Image

A tenant administrator or business group manager creates a blueprint for using an HP Server Automation boot image to deploy HP Server Automation software jobs on machines provisioned from it.

Prerequisites

- Log in to vRealize Automation as a tenant administrator or business group manager.
- Obtain the following information from your fabric administrator:
  - The name of the HP Server Automation server to be used as the value for the EPI.Server.Name custom property.
  - The name of the HP Server Automation image to be used as the value for the Opsware.BootImage.Name custom property.
Optionally, information about the custom properties and values to be applied to all machines provisioned from the blueprint. See Chapter 8 Custom Properties for HP Server Automation Integration.

**Note**  A fabric administrator can create a property group by using the property set HPSABuildMachineProperties, which allows HP Server Automation integration in provisioning by using a boot image, or HPSASoftwareProperties, which allows HP Server Automation integration in software deployment. These property groups makes it easier for tenant administrators and business group managers to include this information in their blueprints.

For information on creating a virtual blueprint, see *IaaS Configuration for Virtual Platforms*.

**Procedure**

1. Select **Design > Blueprints**.
2. In the Actions column, click the down arrow and click **Edit**.
3. Click the **Properties** tab.
4. (Optional) Select one or more property groups.
   Property groups contain multiple custom properties.
5. (Optional) Add any custom properties to your machine component.
   a. Click **New Property**.
   b. Enter the custom property in the **Name** text box.
   c. (Optional) Select the **Encrypted** check box to encrypt the custom property in the database.
   d. Enter the value of the custom property in the **Value** text box.
   e. (Optional) Select the **Prompt user** check box to require the user to provide a value when they request a machine.
      If you choose to prompt users for a value, any value you provide for the custom property is presented to them as the default. If you do not provide a default, users cannot continue with the machine request until they provide a value for the custom property.
   f. Click the **Save** icon ().
6. Click the **Build Information** tab.
7. Select **Create** and the **ExternalProvisioningWorkflow** workflow.
8. Click **OK**.

Your blueprint is saved.

**What to do next**

Publish your blueprint to make it available as a catalog item. See Chapter 9 Publish a Blueprint.
Create a Blueprint for Cloning from an HP Server Automation Template

A tenant administrator or business group manager creates a blueprint that enables the deployment of HP Server Automation software jobs on machines provisioned from it.

Prerequisites

- Log in to vRealize Automation as a tenant administrator or business group manager.
- Obtain the following information from your fabric administrator:
  - The clone blueprint that you want to integrate with HP Server Automation.
  - Optionally, information about the custom properties and values to be applied to all machines provisioned from the blueprint. See Chapter 8 Custom Properties for HP Server Automation Integration.

  **Note** A fabric administrator can create a property group by using the property set HPSABuildMachineProperties, which allows HP Server Automation integration in provisioning by using a boot image, or HPSASoftwareProperties, which allows HP Server Automation integration in software deployment. These property groups makes it easier for tenant administrators and business group managers to include this information in their blueprints.

- If a policy is to be applied to all machines provisioned from the blueprint, you must include the custom property Vrm.Software.IdNNNN where NNNN is a number from 1000 to 1999, and the value is set to the name of the policy, for example Windows_ISMtool.
- The name of the customization specification to be added to the blueprint. See Preparing an HP Server Automation Template for Cloning.
- For information on how to create a blueprint for cloning by using the template and customization specification provided to you by your fabric administrator, see IaaS Configuration for Virtual Platforms.

Procedure

1. Select Design > Blueprints.
2. Locate the clone blueprint that you want to integrate with HP Server Automation.
3. In the Actions column, click the down arrow and click Edit.
4. Click the Properties tab.
5. (Optional) Select one or more property groups.
   
   Property groups contain multiple custom properties.
6  (Optional) Add any custom properties to your machine component.
   a  Click New Property.
   b  Enter the custom property in the Name text box.
   c  (Optional) Select the Encrypted check box to encrypt the custom property in the database.
   d  Enter the value of the custom property in the Value text box.
   e  (Optional) Select the Prompt user check box to require the user to provide a value when they request a machine.
      If you choose to prompt users for a value, any value you provide for the custom property is presented to them as the default. If you do not provide a default, users cannot continue with the machine request until they provide a value for the custom property.
   f  Click the Save icon (✓).

7  Click OK.

Your blueprint is saved.

**What to do next**

Publish your blueprint to make it available as a catalog item. See Chapter 9 Publish a Blueprint.
vRealize Automation includes custom properties that you can use to provide additional controls for HP Server Automation integration. Some custom properties are required for HP Server Automation integration. Other custom properties are optional.

### Required Custom Properties for HP Server Automation Integration

Certain custom properties are required for a blueprint to work with HP Server Automation.

#### Table 8-1. Required Custom Properties for HP Server Automation Integration

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware.VirtualCenter.OperatingSystem</td>
<td>Specifies the vCenter Server guest operating system version (VirtualMachineGuestOsIdentifier) with which vCenter Server creates the machine. This operating system version must match the operating system version to be installed on the provisioned machine. Administrators can create property groups using one of several property sets, for example, VMware[OS_Version]Properties, that are predefined to include the correct VMware.VirtualCenter.OperatingSystem values. This property is for virtual provisioning.</td>
</tr>
<tr>
<td>VirtualMachine.EPI.Type</td>
<td>Specifies the type of external provisioning infrastructure.</td>
</tr>
<tr>
<td>EPI.Server.Name</td>
<td>Specifies the name of the external provisioning infrastructure server, for example, the name of the server hosting BMC BladeLogic. If at least one general BMC EPI agent was installed without specifying a BMC BladeLogic Configuration Manager host, this value directs the request to the desired server.</td>
</tr>
<tr>
<td>Opsware.Software.Install</td>
<td>Set to True to allow HP Server Automation to install software.</td>
</tr>
<tr>
<td>Opsware.Server.Name</td>
<td>Specifies the fully qualified name of the HP Server Automation server.</td>
</tr>
<tr>
<td>Opsware.Server.Username</td>
<td>Specifies the user name provided when a password file in the agent directory was created, for example opswareadmin. This user name requires administrative access to the HP Server Automation instance.</td>
</tr>
<tr>
<td>Opsware.BootImage.Name</td>
<td>Specifies the boot image value as defined in HP Server Automation for the 32-bit WinPE image, for example winpe32. The property is not required when provisioning by cloning.</td>
</tr>
</tbody>
</table>
### Table 8-1. Required Custom Properties for HP Server Automation Integration (Continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opsware.Customer.Name</td>
<td>Specifies a customer name value as defined in HP Server Automation, for example MyCompanyName.</td>
</tr>
<tr>
<td>Opsware.Facility.Name</td>
<td>Specifies a facility name value as defined in HP Server Automation, for example Cambridge.</td>
</tr>
<tr>
<td>Opsware.Machine.Password</td>
<td>Specifies the default local administrator password for an operating system sequence WIM image such as Opsware.OSSequence.Name as defined in HP Server Automation, for example P@ssword1.</td>
</tr>
<tr>
<td>Opsware.OSSequence.Name</td>
<td>Specifies the operating system sequence name value as defined in HP Server Automation, for example Windows 2008 WIM.</td>
</tr>
<tr>
<td>Opsware.Realm.Name</td>
<td>Specifies the realm name value as defined in HP Server Automation, for example Production.</td>
</tr>
<tr>
<td>Opsware.Register.Timeout</td>
<td>Specifies the time, in seconds, to wait for creation of a provisioning job to complete.</td>
</tr>
<tr>
<td>VirtualMachine.CDROM.Attach</td>
<td>Set to False to provision the machine without a CD-ROM device. The default is True.</td>
</tr>
<tr>
<td>Linux.ExternalScript.Name</td>
<td>Specifies the name of an optional customization script, for example config.sh, that the Linux guest agent runs after the operating system is installed. This property is available for Linux machines cloned from templates on which the Linux agent is installed.</td>
</tr>
<tr>
<td>Linux.ExternalScript.LocationType</td>
<td>Specifies the location type of the customization script named in the Linux.ExternalScript.Name property. This can be either local or nfs.</td>
</tr>
<tr>
<td>Linux.ExternalScript.Path</td>
<td>Specifies the local path to the Linux customization script or the export path to the Linux customization on the NFS server. The value must begin with a forward slash and not include the file name, for example /scripts/linux/config.sh.</td>
</tr>
</tbody>
</table>

### Optional Custom Properties for HP Server Automation Integration

Certain custom properties are optional for a blueprint to work with HP Server Automation.

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opsware.ProvFail.Notify</td>
<td>(Optional) Specifies the notification email address for HP Server Automation to use in the event of provisioning failure, for example <a href="mailto:provisionfail@lab.local">provisionfail@lab.local</a>.</td>
</tr>
<tr>
<td>Opsware.ProvFail.Notify</td>
<td>(Optional) Specifies the HP Server Automation user to whom ownership is assigned if provisioning fails.</td>
</tr>
</tbody>
</table>
Table 8.2. Optional Custom Properties for HP Server Automation Integration (Continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opsware.ProvSuccess.Notify</td>
<td>(Optional) Specifies the notification email address for HP Server Automation to use if provisioning is successful.</td>
</tr>
<tr>
<td>Opsware.ProvSuccess.Owner</td>
<td>(Optional) Specifies the HP Server Automation user to whom ownership is assigned if provisioning is successful.</td>
</tr>
</tbody>
</table>

Custom Properties That Make HP Server Automation Software Jobs Available

Depending on how your fabric administrator configures HP Server Automation jobs for vRealize Automation integration, you might have a choice between making all software jobs available to machine requesters to select, or you can specify jobs to apply to all machines provisioned from your blueprint.

Table 8.3. Custom Properties to Make Software Jobs Available

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LoadSoftware</td>
<td>Set to True to enable software install options.</td>
</tr>
<tr>
<td>Vrm.Software.Id</td>
<td>(Optional) Specifies an HP Server Automation policy to be applied to all machines provisioned from the blueprint. NNNN is a number from 1000 to 1999. The first property must start with 1000 and increment in numerical order for each additional property.</td>
</tr>
</tbody>
</table>
Publish a Blueprint

You can publish a blueprint for use in machine provisioning and optionally for reuse in another blueprint. To use the blueprint for requesting machine provisioning, you must entitle the blueprint after publishing it. Blueprints that are consumed as components in other blueprints do not require entitlement.

**Prerequisites**

- Log in to vRealize Automation as an **infrastructure architect**.
- Create a blueprint. See *Checklist for Creating vRealize Automation Blueprints*.

**Procedure**

1. Click the **Design** tab.
2. Click **Blueprints**.
3. Point to the blueprint to publish and click **Publish**.
4. Click **OK**.

The blueprint is published as a catalog item but you must first entitle it to make it available to users in the service catalog.

**What to do next**

Add the blueprint to the catalog service and entitle users to request the catalog item for machine provisioning as defined in the blueprint.